Lynn Allen’s

Tips and
Tricks

Command Line

Command Line

Command Line
Enjoy an improved
user experience
with AutoCAD 2015
along with many
productivity tools that
are certain to help
you take your designs
to the next level!

If you are a fan of the command line—you
will love the many enhancements such as
synonyms, autocorrect and content search.

AutoCorrect
No more of the dreaded “unknown command”! Now if you mistype a command,
AutoCAD will autocorrect to the most relevant command. (Hoorah!)

AutoComplete
AutoComplete now supports mid-string
search capabilities. If you key in “PLANE” for
example, you will get all the commands and/
or system variables that contain the word
PLANE.
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Commands in the AutoComplete suggestion
list are initially displayed in order of their
general popularity. As time goes on—the
suggestion list will adapt to your own usage
behavior (making your AutoCAD smarter and
smarter!)

Synonym Suggestions
When you work on multiple CAD systems—
it is easy to get your nomenclature mixed up!
The new Synonym suggestions will help you
find an appropriate match (and it’s customizable!) For example if you key in SYMBOL,
AutoCAD will offer up the INSERT command.

Content
Timesaver alert! Now you can access layers,
blocks, hatch patterns, text styles, dimension
styles and visual styles from the command
line! For example, if you key in “Door”, you
can quickly insert the preferred door block
from the suggestion list.

Customize your synonyms with the Edit
Synonym tool (Manage ribbon tab).
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Command Line

File Tabs

File Tabs
With all these new command line
options—you will find some are displayed
with expandable categories. Simply select the
+ or use the tab key to cycle through all the
content

Internet Search
Would you like even more information on
a command or system variable? Move the
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cursor over the intended command in the
suggestion list and then select the new Help
or Internet icons in the upper right corner.

Easily create or move from one open
drawing to another with the handy File Tabs
in AutoCAD 2015.

New Tab
You will be greeted by New Tab each time
you open AutoCAD 2015 (or when you use

The Input Search Options dialog (also
available from the right click menu) makes it
easy for you to customize input and search
features.
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File Tabs

the + to create a new tab). It contains two
sliding content frames: Learn and Create.
The Create tab makes it easy for you to
start a new drawing, access recent files and
connect with Autodesk 360. Here you’ll find
various notifications as well as where to
download offline Help.
Use the icons at the bottom of the
Recent Documents list on the Create tab to
switch from thumbnail to text view (or both).

File Tabs

Ctrl+T gets you to New Tab quickly!
Set NEWTABMODE and
STARTUPMODE to 0 to display
AutoCAD 2014 behavior.

File Tabs
File tabs display in the order they were
opened, but you can easily drag and drop
them to change the order. If you run out of
room—an overflow menu will appear at
the right.
A lock icon on a tab indicates
read-only; an asterisk indicates the file has
been modified since the last save.

The Learn tab is filled with What’s New
and Getting Started videos, tips and online
resources.
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Passing the cursor over a file tab will display
preview images of model space and layouts.
If you hover over a preview image—it is
temporarily displayed in the entire drawing
area. You’ll also find the Plot and Publish
tools appear.

Right click on the file tabs to reveal additional
options such as Save All and Close All Except
this Tab. Use Copy Full File Path to quickly
copy a link to your drawing for an email or
use Open File Location as a friendly directory
reminder.

Select the Plus icon to the right of the drawing tabs to access the New Tab. If NEWTABMODE is set to 0 or 2, the Plus icon (+) will
execute QNEW.
If for some reason you prefer to turn off this
cool new tool—you can do so from the File
Tabs control on the View tab of the ribbon.
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User Interface

User Interface

User Interface
The updated modernized UI in AutoCAD®
2015 software is easier to work with and
reduces eye strain.

Color Schemes
Have you been staring at AutoCAD all day?
Give your eyes a rest with the new dark
themed Interface.

You can easily switch AutoCAD back
to the more traditional light theme using the
Color Scheme control on the Display tab of
Options or by using the COLORTHEME system
variable.

You can also search the help file for results
based on the type of user you are.

Help
Do you sometimes have a hard time finding
the various tools in the AutoCAD ribbon?
Now you can use the Find link next to any
tool in Help and a friendly arrow will point
you to its location.

If you are new to AutoCAD—check
out the Hitchhiker’s Guide to AutoCAD
Basics!
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User Interface

User Interface

Workspaces

Galleries

BIM 360

Workspaces are no longer displayed by default in the Quick Access toolbar. You can still
find them on the status bar (who needs them
in two places anyway?)

The new block galleries make it easy to view
and insert blocks directly from the ribbon
(current drawing only).

AutoCAD 2015 makes it easy
to access BIM 360 Glue for
model sharing and clash
detection.

Layouts
You’ll appreciate the layout
preview thumbnails and
the handy new + symbol to
quickly add a new layout.
For those of you who like to
heap on the layouts—you’ll
like the new overflow menu
for easy access to layouts
that extend beyond the
width of the display.

The Classic Workspace has been
removed—time to get onboard with the
ribbon!

You’ll also find helpful galleries for styles such
as dimensions, mleaders, text, tables and
table cells.
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You can now control
the paper background color
in Options.
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User Interface

Improved Graphics

Improved Graphics
Model Space Viewports

Are you tired of the jagged diagonal lines in
AutoCAD? AutoCAD 2015 to the rescue. The
new LINESMOOTHING variable does exactly
that—including arcs and circles! And there is
no reason not to use it as it doesn’t compromise your performance!

Model Space Viewports are easier to identify
and easier to resize. Simply drag the horizontal or vertical viewport boundaries, or the
intersection to resize them.

You can control line smoothing from the
Graphics Performance dialog
(Options=>System).

You can join or remove a viewport by
dragging a boundary to the edge.

The new + icon lets you easily add more
viewports…just drag it to the proper size.
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Improved Graphics

Object Selection

Object Selection
3D Orbit
Enjoy better control of the target point when
you turn off “Enable Orbit Auto Target” from
the 3DOrbit right click menu. Then you can
click and hold the cursor to specify the pivot
point.

A small spherical icon will display to indicate
the pivot point.

We spend so much of our AutoCAD time selecting and editing objects—check out these
new additions:

You’ll find that faces and 3D solids
are much easier to identify when selected
as well.

Selecting Objects

Moving objects will be clearer with the new
faded deletion effect.

When selecting objects the geometry appears
thicker and darker (or lighter depending on
your background color).

Now you will see color, linetype and lineweight for lines and plines as you draw them!
Complex linetypes display true to form as you
draw and edit them.

After selecting objects—they change color
and remain thickened so you are certain
you’ve selected the correct objects! (only if
hardware acceleration is on).
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Set COMPLEXLTPREVIEW to 0 to turn
this feature off.
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Object Selection

Lasso Selection
Click and drag your cursor to use the new
Lasso selection—click and release for the
traditional rectangular selection.

Object Selection

The new Command Preview control on the
Selection tab of Options enables/disables this
cool new feature.

Selection badges indicate crossing or window.

Relevant badges also display for Copy, Move,
Scale, Zoom and Erase! Now you’re always in
the know.

Inspection badges display when using
Inquiry commands.

This behavior can be turned off on
the Selection tab of Options.

Command Preview
Preview the results of Trim, Extend, Lengthen, Break, MatchProp, Fillet, Chamfer and
Offset!
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Badges
AutoCAD 2015 has added handy, relevant
badges that provide you with contextual
feedback right next to the crosshairs.

Rotation badges display during a Rotate
operation (and indicate clockwise or counterclockwise based on the drawing units).
The crosshairs have been removed
from the inside of the pickbox to make it easier to see what you’re selecting.

TIPS AND TRICKS | 17

Everyday Command Improvements

Everyday Command Improvements

Everyday Command Improvements
Many improvements have been made to the
bread and butter commands of AutoCAD.

Natural Ordered Sort for Layers
If you number your layers, you’ll be thrilled
with this improvement! Now numbered layers
are sorted in their natural order such as 1, 2,
4, 6, 10, 21, 25 (as opposed to 1, 10, 2, 25, 21,
4, 6).

Layer Merge

Arcs

LAYMRG has been incorporated into the Layer Manager. Right click to merge 2 or more
layers together onto one layer (and automatically delete the now empty layers).

Use the Ctrl Key to switch arc and polyarc
directions!

Isometric Drafting Environment
A new tool on the status bar makes it easy to
switch from one isoplane to the next.

Change the XREF type or path for multiple
selected xrefs simultaneously from the rightclick menu in the XREF Manager.
Toggle between Attach and
Overlay in the XREF Manager with a simple
double-click.

Set the new SORTORDER system
variable to 0 to restore legacy behavior.

Sheet Sets
The CreateDate field (stored in the template
file) displays the creation date of the new
sheet (not the date of the template file).

Plot Styles
Now CONVERTPSTYLES supports spaces!

Polylines
Now you can fillet a polyline or polyarc to
itself.
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XREF Enhancements
XREF linetypes are no longer displayed on the
linetype list of the ribbon or the Properties palette (you can’t modify them there
anyway!). XREF layers are still displayed in the
ribbon (but not in Properties).
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Reality Computing

Reality Computing

Reality Computing
More and more people are incorporating
scans into their designs. Autodesk® ReCapTM
makes working with 3D laser scans a breeze!

Autodesk ReCap
Use Autodesk ReCap to convert scan file data
from a variety of popular formats to a high-

speed point cloud that can be viewed and
edited in AutoCAD and other products
(including Autodesk Revit and Autodesk
Inventor).
Autodesk ReCap is a separate application that is installed with AutoCAD 2015
(by default).

Access Autodesk Recap or
attach a ReCap point cloud
(RCP and RCS) from the
Insert tab on the ribbon.
Use the Attach Point Cloud dialog to select
the file, scale, insertion point and rotation
angle (and to display valuable data about
your point cloud).
Check out the new Use Geographic
Location option.

The contextual ribbon will switch to a Point
Cloud tab when a point cloud is selected.
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Reality Computing

Display
Now you can increase the point size to visually fill in gaps. Use the Level of Detail slider to
set the density for all point clouds.
Use Options=>3D Modeling tab to
control the maximum points displayed on the
screen for your point clouds. AutoCAD 2015
supports up to 25 million points!

Reality Computing

The colorization options help you better
visualize your point cloud.
Elevation and Classification are new
to AutoCAD 2015.

Lighting
The new Lighting tools control various
lighting effects.

You can continue cropping your point
cloud by changing the view.

Point Cloud Manager
Use the new Point Cloud Manager to work
with multiple point clouds.

Colorization
Customize your colorization with the new
Point Cloud Color Map dialog.

Double click on a point cloud to view
the model from its scan position.

Cropping
Use the cropping tools (Rectangular, polygonal or circular) to clip your point clouds.
Use the new Invert tool to reverse
displaying points inside rather than outside
the clipping boundary.
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Geographic Location

Geographic Location

Geographic Location
Object Snaps
Control the Point Cloud object snaps from
the 3D Object Snap tab of Drafting Settings.
Add 3D Object Snap to the status
bar for easy access to the point cloud object
snaps.

When you add a geographic location to your
drawing, you reap many benefits from all the
geographic data that goes with it!
• Display your drawing on map services such
as Google Earth.
• View it in the context of its actual location
(great for sun studies).
• Geo-referenced blocks and images automatically go to their correct location (with
the correct scale!)
• Navigate around in your drawing while
you’re in the field! (if your computer is
GPS enabled).
Set a geographic location
using the Set Location tool.

Easily search for an address
or latitude and longitude
from a map (if signed into
your Autodesk account) or
by selecting a KML/KMZ file.
If you aren’t signed in—you
can still specify latitude and
longitude.
Drop a marker on to the map
to mark the spot! Move the
marker as often as needed.
Select a relevant coordinate
system (which also defines
the scale of the map). You
can easily modify the drawing units.
Pick the corresponding geographic location
in your drawing and specify the north
direction.

Use the UCS tool, Object option to
align the current UCS to a plane in a point
cloud.
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Use the Geolocation ribbon tab for modifying the geolocation and map display. Easily

switch between aerial, road, or hybrid map
(or turn off the map completely).
If you’re in the field, use the Locate
Me tool to identify and mark your current
location.
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Geographic Location

Annotation

Annotation
Now you can capture an area or viewport for
plotting purposes and to preserve the current
map data. This map will be embedded into
the drawing (no need for internet access for
viewing or plotting).

Map Resolution
Use the new Map Image Resolution tool to
retrieve a higher or lower resolution image.
Just because an image is higher
resolution—doesn’t mean it is more recent!

Annotation is an important part of our
designs—check out these timesavers!

Text
Single line text remembers the last justification setting!

Bullets and Numbering
Mtext now has automatic bullets or numbering. Begin a line with a symbol, number or
letter followed by one of these symbols:
. , ) > } , ] and then a tab to create a bullet
or numbered list. Click the icon for more
options.

Move, resize or rotate the image boundary.
The online map data will automatically
update!

Use the new Match Properties tool in the
Text Editor ribbon to apply properties between selected text within an Mtext object.
Works with dimensions and
tables too!

Sub/Superscript
Highlight the text and use the new
Superscript/Subscript tools on the ribbon.

Use Backspace to remove automatic
bullets and numbering.
Use the new slider bars on the Map Image
ribbon tab to adjust the brightness, contrast
and fading (so you can see your AutoCAD
geometry in the background).
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MatchProp

Smart Caps Lock
AutoCAD will automatically correct your text
(and turn Caps Lock off) if you accidentally
had Caps Lock on while you’re holding down
the Shift Key.
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Annotation

Annotation

Mtext
You’re going to love the new transparent
background (so you can see any objects
underneath).
Modify the height and width of columns at
the same time with the new corner resizer.
Modify them independently by using the
arrows on each edge.

AutoStack
It’s easier to AutoStack! Just put a forward
slash between numbers: 1/20.
Click on the icon for other stack options.

Use Stack and AutoStack
properties to further control
the stacking.

Dimensions
Set the new system variable
DIMCONTINUEMODE to 1
to create Continued and
Baseline dimensions with the
same dimension style as the
base dimension!
Double-clicking on a
tolerance object opens the
Geometric Tolerance dialog
box (better than Quick
Properties).
No more snapping
to extension lines by accident! Object snaps ignore
extension lines when creating dimensions. (Control
this behavior in Options=>
Drafting tab.)
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Annotation

Autodesk 360

Autodesk 360
Hatch

Text Alignment

It is now possible to edit multiple hatch objects from the ribbon or from the command
line version of the hatch editor.

The new TEXTALIGN command quickly aligns
text to existing text (or by selecting points).
You can easily control the spacing or alignment direction.

Hatch remembers the previous method for
selecting objects to hatch (pick internal point
or select objects).

Attributes
Now when you insert blocks with attributes—the dialog box displays by default
(ATTDIA set to 1).

It’s all about the cloud, baby! Connect to
your secure Autodesk 360 account for file
sharing, customization syncing, and more.

Open Local Sync Folder

Autodesk 360 tab

Launch Website

Use the Autodesk 360 tab for all things related to your Autodesk 360 account.

Share Document
Makes it easy to save and share your document with others via Autodesk 360. You
provide the email addresses and comments—
Autodesk 360 does the rest!
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Opens the Autodesk 360 folder your drawing
is being synced to.

This tool takes you online to your stored
documents and folders via browser.
You’ll also find Autodesk 360 access
in many of the Select File dialog boxes.
When you upload drawings from AutoCAD to
Autodesk 360, external references and other
dependent files upload as well!
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Autodesk 360

Design Feed

Design Feed
Settings Sync
Be sure to set up your cloud settings to
control when your design data and custom
settings are synced. Choose to automatically
store your design data each time you save, or
only when you specify.

customization files, Options and support files
to Autodesk 360 so you can restore them
onto any computer!

Choose Settings
Choose which settings you’d like Autodesk
360 to automatically sync.

The Design Feed tool displays a palette where you
can enter text messages and
attach images to be shared
online through Autodesk
360.
Posts will remain with the
related drawings on the
desktop, web and across
mobile devices.
Access Design Feed from the
Autodesk 360 ribbon tab.

Sync my Settings
We all set up AutoCAD to work the way we
like to work! Now you can save and sync
those settings with Autodesk 360. Save your
program appearance, profiles, tool palettes,
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Design Feed

AutoCAD 360

AutoCAD 360
Associate a message with a location in your
drawing and a corresponding bubble will
display. When the post is selected in Design
Feed, AutoCAD zooms in accordingly and
vice versa.

The data and associated images are saved
to Autodesk 360. When you save the file
under a different file name—you can opt to
copy the Design Feed info with it. A similar
option appears in eTransmit, Archive or
DWG Convert.

Use the Settings button on the
Design Feed palette to control the display of
bubbles.

Have you tried Autodesk® AutoCAD® 360
web app yet? AutoCAD 360 lets you view,
edit, and share drawings through the web
or mobile device (take your drawings on the
road!).
Collaborate with others on the same drawing
in real time! Use the basic editing features to
mark-up a drawing file. Use the Timeline tool
for a detailed design history.

Tag others via email to notify them of your
post (will also appear within AutoCAD).

Download the free* app for
iOS mobile devices at the
App Store. Also available for
the Android.
It’s easily accessed from
inside AutoCAD via the
Autodesk 360 tab or visit
www.autocad360.com
today!

Give AutoCAD 360 a try—
did I mention it’s free*?

Design Feed makes corresponding with
others about an AutoCAD drawing so much
easier!
Resolve the thread to hide it when
the post is no longer needed or active.

* Free products and services are
subject to the terms and conditions
of the end-user license agreement
that accompanies them.
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Added Extras

Added Extras

Added Extras
Are you using a Windows® 8 touch-enabled
device? Use the control on the System tab of
Options to display a touch mode ribbon panel
(when a touch screen is detected). You will
be on the road to smoother pan and zoom
performance in no time!

Use the Exchange App Manager to view and
update. Right click on an app to rate, uninstall or learn more information about it.

Autodesk Exchange Apps
Get direct access to downloadable applications and content that can increase your
productivity. Simply click on the big X on
Infocenter.

A double click on an app in the
Exchange App Manager will automatically
provide more info about that app.

Multiple search paths for plot files
You can now specify multiple folders for PC3,
PMP, CTB, and STB files in Options.
Several valuable apps such as the Featured
Apps ribbon tab, the Exchange App Manager
and the SketchUp Import app are automatically installed in AutoCAD 2015.
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Security!
AutoCAD 2015 offers extra security controls
to help protect your drawings. Set the
Trusted File Search Path on the Files Tab in
Options to prevent unauthorized execution
of files such a scripts, AutoLISP or VBA
applications.

You will also find new Executable File settings
on the System tab of Options.
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Added Extras

Added Extras

AutoCAD Subscription Options
Desktop Subscription
Enjoy access to the latest
software releases, technical
support, flexible licensing,
and a variety of Autodesk
360 cloud benefits.

Language Packs

Autodesk Application Manager

Do you need to install multiple languages
of AutoCAD on your computer? Now you
can install one full product and then add
subsequent languages via Language Packs
(from the Help menu). Saves so much time
and space!

This desktop tool helps you stay current with
the latest updates for all your Autodesk applications. The Autodesk Application Manager
will send you timely messages about new
service packs, hot fixes, etc.
The Application Manager seamlessly downloads the files from the cloud and installs
them for you.
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Maintenance Subscription
Maximize the value of your
perpetual license with the
latest upgrades, flexible
licensing, technical support,
and access to select cloud
and software services.

TrustedDWG
Not all “.dwg” files are created equal.
TrustedDWG technology helps preserve
the integrity of your designs throughout
the review process.

Cloud Service Subscription
Extend your workflow to
the cloud for virtually infinite
computing power, collaboration tools, and access to your
files and software—almost
anytime, anywhere.
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Autodesk AutoCAD Design Suite

Autodesk AutoCAD Design Suite

Autodesk AutoCAD Design Suite
Enhance the power of
AutoCAD with easy-to-use
visual communication solutions. Autodesk AutoCAD
Design Suite helps designers
work more creatively, rapidly
evaluate designs in context
and effectively communicate
and sell ideas.

40 | TIPS AND TRICKS

Autodesk AutoCAD Raster Design
Get more value from your raster imagery
(such as scanned drawings, maps, and aerial
photos) with Autodesk AutoCAD Raster
Design.
• Easily clean up, edit, enhance and maintain
scanned drawings in a familiar AutoCAD
environment (includes despeckle, bias,
mirror, and touchup)
• Raster to Vector Conversion, including OCR
(Optical Character Recognition) gives you
accurate results when you create lines and
polylines from raster data
• Use standard AutoCAD commands on
raster regions and primitives; easily erase
raster lines, arcs, and circles
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Autodesk AutoCAD Design Suite

Autodesk AutoCAD Design Suite

Autodesk 3ds Max
Design
(Available in Premium)
Create cinematic-quality 3D
visuals with animation, character, effects, and point-andshoot rendering and lighting
analysis tools.

Autodesk Alias

Autodesk Showcase

Autodesk Mudbox

Quickly and easily transform your AutoCAD
designs into compelling imagery, movies, and
interactive presentations for design reviews
and sales pitches.

Refine your models with a powerful textured
painting and digital sculpting toolset while
finessing the details of your ultra-realistic
3D creations.
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(Available in Ultimate)
Enjoy a range of sketching,
modeling, surfacing, and
visualization tools with
industrial design and Class-A
surfacing software.
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